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A PUBLICATION OF THE BIRMINGHAM APPLE CORE

Please e-mail your 
questions or comments to  

Bill  Henry, Editor
(henryw@bellsouth.net)

BAC March Meeting

The March meeting will be held on Satur-
day Marchy 12th, at 10:00am at the Home-
wood Library in  room 116 (lower level).  
  The topic for the meeting will be “iLife 
ʻ05  ̓.

Come early and enjoy coffee, doughnuts 
and cookies, plus.......

http://www.applecore.org
Jef Raskin, Apple employee 
#31 and creator of the Mac 

concept dies at age 61 

Jef Raskin, a mathematician,  orches-
tral soloist and composer, professor, bi-
cycle racer, model  airplane designer, and 
pioneer in the field of human-computer  
interactions, died peacefully at home in 
California on February 26th,  2005 sur-
rounded by his family and loved ones. 
He had recently been  diagnosed with 
pancreatic cancer.

Jef created the Macintosh computer  
as employee number 31 at Apple in the 
early 1980s, revolutionizing  computer 
interface design. Jef invented “click and 
drag” and many other methods now taken  
for granted  by computer users. He named 
the Macintosh project after his favorite  
variety of apple, the McIntosh, modify-
ing the spelling for copyright  purposes. 
Jefʼs article “Holes in the Histories”  ad-
dresses  some  popular misconceptions 
about the Macintosh Project. Jef strongly  
believed that computers should make 
tasks easy for people, not the  other way 
around. For twenty-five more years, his 
work focused on  improving interfaces, 
culminating in his book, The Humane 
Interface  (Addison-Wesley, 2000). Jef 
created the Raskin Center for Humane  
Interfaces (RCHI), <http://www.rask-
incenter.org>,  which will soon release 
a  preview of Archy, a culmination and 
exemplar of his design principles.  Ar-
chy redesigns the basic building blocks 
of computing to demonstrate  an entirely 
new paradigm for computer use. RCHI 
will continue under  the technical leader-
ship of Jefʼs son, Aza Raskin.

Jef worked until the last days of  his 
life to finish the code for Archy. He told a 

friend ten days before  he died, “When 
people get  a  chance to work in Archy 
and see how much easier it is to do their  
work, weʼll get enormous support.” He 
had completed almost all of  the  basic 
work by the time his health took a turn 
for the worse a few days  later.

Jef viewed good design as a moral  
duty, holding interface designers to  
the same ethical standards as surgeons. 
Alluding to Isaac Asimovʼs  first law 
of robotics, one of Jefʼs mantras was 
that “any system  shall  not harm your 
content or, through inaction, allow 
your content to come  to harm.” Ar-
chy implements that principle by mak-
ing it impossible  to  permanently lose 
your work. Archy also replaces mouse 
movements, which  many text editing 
programs require, with much faster 
“Leap” keystrokes,  reducing the likeli-
hood of carpel tunnel syndrome.

Jef originated the Macintosh proj-
ect in 1979 despite strong opposition  
from Apple co-founder Steve Jobs and 
led the effort for the crucial  first three 
years. 

continued on page 2



BAC Disk of the Month

For Sale/Wanted

**************
Do you have computer related 

items for sale or  is there an item 
that you would like topurchase?

We will list the item in this space 
free of charge to currentBAC mem-
bers.

Send information by the 25th 
of each month to the editor at: 
henryw@bellsouth.net.
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2005 BAC Board of Directors
The BAC CDOM (Disk of the 

Month) is available at each BAC 
meeting. These CDs contain updates, 
shareware, and freeware.

The cost is $2 per disk and is avail-
able at the BAC meetings from Disk 
Librarian Jerry Jenkins.

March 2005 CDOM
Description

Budget 4.5.1...Shareware
Highly rated financial utility.  Helps 

manage the monthly bills.  Requires 
OS 10.1 or higher.

FolderIconX 2.0.3...Shareware
Create custom folder icons and doc-

ument icons.  Requires OS 10.2.1 or 
higher, or OS 10.3.x   New version OK 
for OS 10.3.7

Freecell 2.0.2...Freeware
Solitaire card game - highly rated.  

Requires OS 10.2 or higher.

Graphic Converter 5.5x...Share-
ware

Many, many improvements in this 
updated version.  A good app to change 
graphics formats and to edit and cor-
rect digital photos.  Requires Mac OS 
10.1.3 or  higher.

Home Audit 2.0.5...Shareware
Inventorying system for all your 

household goods - just in case of fire 
or theft.  Requires OS X.

Macaroni 2.0.4...Shareware
Does the basic Mac maintainance 

needed, either manually or automati-
cally, with having to leave your Mac 
on going full blast (no sleep) over 
night.  Requires OS 10.1.2

Simple Chord 2.3.2...Shareware
Reference to chords for musicians.  

Gives graphic of keyboard with chords 
hilighted.  Will also play chords.  Re-
quires OS 10.2 or higher.

March Door Prizes
The following list of door prizes will 

be awarded at the BAC meeting, the 
NEW iLife 05; a copy of the monthly 
CDOM, and a one-month rental of any 
of the instructional CDs that are in our 
Library. 
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Tex-Edit Plus X 4.9.1...Shareware
Easy-to-use text editor, but more 

like a word processor.  This new ver-
sion is scriptable.  Requires OS 10.1 
or higher.

VueScan X 8.1.35...Shareware
Updated, keeps getting better and 

covers more scanners.  In most cases, 
it replaces and improves the original 
scanner driver.  This version now re-
quires Mac OS 10.2.8 or higher.

Raskin contʼd from page 1
He left Apple in 1982 to found Infor-

mation  Appliance Inc., where he cre-
ated the award-winning Canon Cat in  
pursuit of his vision that a computer 
should be an easy-to-use tool.  Despite 
the rapid sale of twenty thousand units, 
Canon terminated the  project due to 
an internal dispute. Some Canon Cat 
owners report  continuing to use their 
Cats to this day.

After a decade studying cognitive 
psychology, Jef established a  scientif-
ic basis for the design of man-machine 
interfaces, bringing  interface design 
out of the mystic realm of guruism.

In his 2000 book The Humane 
Interface,  Jef coined the term and 
founded the field of cognetics, “the 
ergonomics of the mind,” transform-
ing  interface design into an engi-
neering discipline with a rigorous  
theoretical framework. His book, 
translated into more than nine lan-
guages, has gone through numerous 
printings and become the standard  
text for more than 100 computing 
courses around the world.

His sculptures have been exhibited 
at New Yorkʼs Museum of Modern 
Art.  One is included in the permanent 
collection.

continued on page 3
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Apple Unveils New iPod mini 
Starting at Just $199

Apple® unveils the second generation iPod® mini lineup 
with a new 4GB model priced at just $199 and a new 6GB 
model with 50 percent more storage priced at $249. Both 
iPod mini models feature increased battery life of up to 18 
hours, USB charging and an ultra-portable, lightweight de-
sign available in four vibrant colors.

 “The iPod mini is now available at the magic price point of 
$199,” said Steve Jobs, Appleʼs CEO. “At this breakthrough 
price point, and with more than twice the battery life, the 
new iPod mini should appeal to even more music lovers.”

 iPod mini works effortlessly with Appleʼs iTunes®, pro-
viding music lovers with access to the iTunes Music Store, 
the number one digital music service in the world. iPod mini 
features Appleʼs patent-pending Auto-Sync which works 
seamlessly with iTunes to automatically download an entire 
digital music library onto iPod mini with just one click, keep-
ing it up-to-date whenever iPod mini is plugged into a Mac® 
or Windows computer using USB 2.0. In addition to keeping 
the iPod mini up-to-date, plugging directly into the USB 2.0 
port will also conveniently charge the iPod mini—so, one 
connection does it all.

 Appleʼs iPod, the iTunes jukebox and the iTunes Music 
Store are leading the digital music revolution. With over 10 
million iPods sold to date, the iPod is the worldʼs most popu-
lar digital music player, and the iTunes Music Store is the 
number one online music store with over 70 percent market 
share. The new iPod mini is a member of Appleʼs wildly 
popular iPod family for both Mac and PC which includes the 
fourth generation iPod, the iPod photo, the iPod U2 Special 
Edition and iPod shuffle

Availability: 
The 4GB and 6GB models of iPod 

mini for Mac or Windows are avail-
able worldwide immediately in a 
choice of silver, pink, blue or green. 
iPod mini includes earbud head-
phones, a belt clip case, a USB 2.0 
cable, and a CD with iTunes 4.7.1 for 
Mac and Windows computers.

 An optional USB power adapter is 
available for $29 (US) which easily 

charges iPod mini when traveling. Other accessories include 
the iPod Dock for $39 (US) for desktop syncing and charg-
ing, in-ear headphones for $39 (US), an arm band for $29 
(US), a lanyard for $19 (US) and FireWire® cable for $19 
(US). Laser engraving is available for iPod mini for free 
from the Apple Store (www.apple.com) and can include two 
lines of text with up to 23 characters per line.

 iPod mini requires a Mac with a USB 2.0 port or FireWire* 
and Mac OS® X version 10.2.8 or 10.3.4 or later; or a Win-
dows PC with a USB 2.0 or FireWire port, or USB 2.0 or 
FireWire card and Windows 2000, with Service Pack 4 or 
later, or Windows XP Home or Professional with Service 
Pack 2 or later.

 All iPods include rechargeable batteries which have a lim-
ited number of charge cycles and may eventually need to 
be replaced. Battery life and number of charge cycles vary 
by use and settings. See www.apple.com/batteries for more 
information.

 *Firewire options require an optional cable, sold sepa-

RASKIN contʼd from page 2

Jefʼs life and work are the subject of a documentary in 
progress,  which will continue to gather information and in-
terviews from people  who knew him. More information is 
available at jefthemovie.com.  Jef  is survived by his wife of 
23 years, Linda Blum; his children, Aza,  Aviva, and Aenea; 
and his children in all but name, Jenna and Rebecca.  

For more information on Jef Raskin see the following web 
sites:

http://jef.raskincenter.org
http://mxmora.best.vwh.net/JefRaskin.html
http://en.wikipedia.org/wiki/Jef_Raskin
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Apple Updates iPod photo Lineup

New Slim 30GB Model Starts at Just $349

Apple®  updated its iPod® photo lineup by introducing a 
new slim 30GB model, holding up to 7,500 songs, for just 
$349 ($150 less than the previous 40GB model which is no 
longer listed in the lineup of iPod Photos) and a new 60GB 
model, holding up to 15,000 songs, for $449 ($150less 
than previous 60Gb model). Designed to take your entire 
music and photo libraries with you wherever you go, both 
iPod photo models feature a stunning high-resolution color 
screen for displaying photos and enhancing the entire iPod 
music experience. Both models hold up to 25,000 digital 
photos and will feature the ability to import photos from 
your digital camera via the new iPod Camera Connector for 
instant viewing and slide show playback on iPod photo.

 “The new slim 30GB iPod photo at just $349 lets music 
lovers enjoy their iPod in full color, including album art-
work along with their personal photo library,” said Steve 
Jobs, Appleʼs CEO. “And now you can import photos from 
your digital camera directly into iPod photo with the op-
tional iPod Camera Connector.”

 iPod photo works effortlessly with Appleʼs iTunes®, pro-
viding music lovers with access to the iTunes Music Store, 
the number one digital music service in the world. iPod 
photo features Appleʼs patent-pending Auto-Sync which 
works seamlessly with iTunes to automatically download 
an entire digital music library onto iPod photo with just one 
click, keeping it up-to-date whenever iPod photo is plugged 
into a Mac® or Windows computer using FireWire® or 
USB 2.0, the standard amongst both Mac and PC users to 
both charge and update any iPod.

 The new iPod Camera Connector is an optional accessory 
that enables customers to connect their digital camera to 
iPod photo and import their photos into the iPod. By simply 
connecting the iPod Camera Connector and a digital cam-
era*, customers can easily transfer digital images to their 
iPod photo, providing tremendous storage space so they 
can take more pictures. Imported photos are immediately 
viewable on iPod photoʼs crisp color screen, and can also 
be brought back to iPhoto® on the Mac or various photo 
applications on the PC. The iPod Camera Connector is ex-
pected to be available in late March for $29.

 Appleʼs iPod, the iTunes jukebox and the iTunes Music 
Store are leading the digital music revolution. With over 
10 million iPods sold to date, the iPod is the worldʼs most 
popular digital music player, and the iTunes Music Store 
is the number one online music store with over 70 percent 

market share. The new iPod photo is a member of Appleʼs 
wildly popular iPod family for both Mac and PC which in-
cludes the fourth generation iPod, the iPod mini, the iPod 
U2 Special Edition and iPod shuffle.

 Availability: The 30GB and 60GB models of iPod photo 
for Mac or Windows are available worldwide immediately.   
iPod photo includes earbud headphones, a USB 2.0 cable, 
a USB power adapter and a CD with iTunes 4.7.1 for Mac 
and Windows computers.

 Optional accessories with the following suggested retail 
prices include the iPod Dock for $39 (US), in-ear head-
phones for $39 (US), the iPod Camera Connector for $29 
(US) and FireWire cable for $19 (US). Laser engraving 
is available for iPod for free from the Apple Store (www.
apple.com) and can include two lines of text with up to 27 
characters per line.

 iPod photo requires a Mac with a USB 2.0 port or 
FireWire**, Mac OS® X version 10.2.8 or 10.3.4 or later 
and iPhoto 4.0.3 or later; or a Windows PC with a USB 2.0 
or FireWire port or USB 2.0 or FireWire card and Windows 
2000 with Service Pack 4 or later, or Windows XP Home or 
Professional with Service Pack 2 or later, and Adobe Pho-
toshop Album 2.0 or Elements 3.0 or later.

 All iPods include rechargeable batteries which have a 
limited number of charge cycles and may eventually need 
to be replaced. Battery life and number of charge cycles 
vary by use and settings. See www.apple.com/batteries for 
more information. Music capacity is based on four minutes 
per song and 128-Kbps AAC encoding; photo capacity is 
based on iPod-viewable photos transferred from iTunes.

 *Support varies depending on make, manufacturer and 
model of digital camera.

 **Firewire options require an optional cable, sold sepa-
rately.

SUMMARY OF NEW iPODS
 iPod Mini
 - New 6GB Model. $249
 - 4GB Model. $199
 - Up to 18hrs Battery Life
 - 4 Colors
 iPod Photo
 - 30GB. $349
 - 60GB. $449
iPod
 - 20GB  $299
iPod Shuffle
- 512MB $99
- 1GB    $149
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Apple is testing a new 
web chat support service 

Apple is testing a new web chat support service for iMac 
customers thatʼs available 24 hours a day, 7 days a week. 
If you have an iMac and need help, give it a try and tell 
us what you think. To use this service, you will need one 
of the following browsers: Safari 1.1 or later, Microsoft 
Internet Explorer 5.2 or later, or Netscape 7.2 or later (on 
Windows, we support Internet Explorer 5.0 or later). 

 To start a chat session, just enter your name, your iMac 
serial number, and click “Start a Web Chat.”

 First Name 
 
Last Name 

iMac Serial Number 

 Why Web Chat?
 Itʼs fast, itʼs easy, itʼs convenient, and youʼll get proac-

tive, comprehensive help from a real live person right here 
in your browser. If you canʼt find what youʼre looking for 
on Appleʼs iMac Support pages, give chat support a try. A 
support agent can even send you helpful web pages while 
youʼre chatting. 

 Am I eligible for Web Chat support?
 You are if you purchased your iMac less than 90 days ago 

or if your iMac is covered under an AppleCare Protection 
Plan. If you have a hardware issue, and your iMac is over 90 
days old but less than a year old and isnʼt  covered under an 
APP, you may be eligible for hardware support—check  the 
warranty documentation that came with your iMac. Please 
call  Apple or your local Apple Authorized Service Provid-
er. 

http://www.apple.com/support/chat/

Digital Turntable
This oneʼs a little off-topic, but a lot of us would like to dig-

itize our vinyl records: 45s, 78s and LPs. The highest qual-
ity affordable solution we know of is Stantonʼs STR8series 
turntable ($240-$499), which has a digital output! Recent 
G5 Power Macs have a digital audio input, and by plugging 
this turntable into that input, you have the cleanest signal 
possible for digitizing your music. (When using analog turn-
table connections, it is notoriously difficult to avoid ground 
hum and other noisy interference.) The turntable also has a 
mini stereo input that you can use to convert your tape player 
output to a digital signal. To find the best price, search www.
froogle.com for Stanton STR8-80, STR8-100 or STR8-150. 
    Design Tools Monthly

   
Dirty Red Dot
Why does the red close button at top left of your file some-

times have a black dot in it? The black dot indicates the file 
has not been saved since the latest changes.

   Mouse Droppings, Corvallis, OR

iPhoto Rx
If iPhoto becomes unstable or runs super slow, it may have 

a confused image database. To rebuild its database, hold 
down the Option and Shift keys while launching iPhoto. If 
the problem still exists, try rebuilding it again until itʼs fixed. 
MacAddict.  Design Tools Monthly

    
iPhoto Trash
iPhotoʼs Trash is not the same as the Mac OS Trash. Delet-

ing a picture in iPhoto just puts it in iPhotoʼs Trash. To re-
move it from your hard drive, you must go to the File menu 
in iPhoto and choose “Empty Trash.”

    Design Tools Monthly

Bigger Album Pictures
Q: Where can I get bigger album images for my iTunes 

collection? The thumbnails on Google and Amazon.com are 
so small.   A: Check out Walmartʼs website (www.walmart.
com), which has 500-by-500-pixel images that dwarf Ama-
zon.comʼs 300 by 300 thumbnails. Ben Veronis

    MacAddict Magazine

Best Internet Sites
What are the very best sites on the internet? Webby Awards 

judges sites and publishes a list of the best sites. They list 
sites in Commerce, Education, Games, Humor, Music and 
News, among many categories. Visit them at http://www.

webbyawards.com/main/ webby_awards/nominees.html
   Mouse Droppings, Corvallis OR
Cropping in Preview
Why does everyone keep saying that Preview canʼt crop 

an image? Get the “Select Tool” from the Tools menu, or 
type Cmnd/3, or, if you have the Switch Tool Mode button 
installed in the Toolbar, just click on the marquee icon.

The pointer turns into crosshairs and you just drag to define 
the area you want to crop to. The surrounding area gets cov-
ered with translucent grey. You can even adjust its position 
and size afterward, if you need to. Then, select “Crop Im-
age” from the Tools menu, or type Command/ K, or, if you 
have it installed in the Toolbar, click the Crop Image icon.

 All you have to do is save it or export it in the phormat  
phlavor that suits your phancy. 

   Phredd in Nawfuk, Virginny, USA



The PEEL6

ComSouth

Alabama’s Apple Source
since 1988!

ComSouth offers
a complete selection  of

Macintosh
hardware, software, service, 
extended warranties, and 

Birmingham 942-9622
State-wide 800-536-0301

www.comsouth.com
225 Oxmoor Circle • Suite 810

Homewood, AL  35209
Authorized

Sales & Service

    

• Consultation        • Sales
• Installation         • Training         
• Digital Imaging Solutions Chris Perry

Authorized 
Value Added Reseller
and Service Provider

1722-B 28th Ave. So., Homewood, AL 35209
Phone (205) 870-7044            Fax (205)780-1944

e-mail: chris@perrycomputer.com
www.perrycomputer.com

Be sure to check your mailing label for your BAC renewal month.
To renew, mail $30 to BAC, PO Box 59745, Birmingham, AL 35259

Bill Henry, Editor
2438 Mahaska Drive 
Birmingham, AL 35244

McKinney Technologies, Inc.
Simplifying Technology

1923 29th Ave., So.
Homewood, AL  35209
Ph: 205-802-7886  Fax: 205-802-7898
e-mail: info@mckinneytech.com

Apple Consultants Network
Authorized Sales & Service

Specializing in Consulting, Support, Maintenance, 
Service & Authorized Repair for the Apple Macintosh



PLACE YOUR AD 
HERE

CONTACT TED GALLOWAY


